Integrating Cisco CTI OS Into a Citrix MetaFrame Presentation Server/Microsoft Terminal Services Environment

Release 7.5(1)
July 2008
Contents

Chapter 3

About this Guide 3-v

Objective v

Important Note About Cisco IPCC Solution Deployment v

Obtaining Documentation vi

Cisco.com vi

Ordering Documentation vi

Documentation Feedback vi

Obtaining Technical Assistance vii

Cisco Technical Support Website vii

Submitting a Service Request vii

Definitions of Service Request Severity vii

Obtaining Additional Publications and Information viii

Chapter 1

Integrating Cisco CTI OS into a Citrix MetaFrame Presentation Server Environment 1-1

Final Draft Introduction 1-1

Limitations 1-1

Supported Desktop Systems 1-1

Supported Platforms 1-2

Supported Citrix ICA Clients 1-2

Supported MTS Clients 1-2

Installing and Configuring CTI OS under the Citrix MetaFrame Presentation Server or Microsoft Terminal Services 1-3

Install Cisco CTI OS 1-3

Configuring the Call Center Agent Windows Users 1-3

Configuring the System Registry After Installation 1-4

Configuring Tracing 1-4

Publishing CTIOS Clients in Citrix MetaFrame Presentation Server 4.0 1-5

Configuring a Citrix ICA Connection 1-11

Using the Citrix Program Neighborhood Client 1-11

Using the Citrix Program Neighborhood Agent 1-17

Using the Citrix Web Client 1-18

Configuring Microsoft Remote Desktop Connection 1-18
APPENDIX A  Registry Settings  A-1
About this Guide

Purpose

This document is intended to guide a Citrix administrator through the installation and configuration of Cisco CTI OS Release 7.5(1) in a Citrix MetaFrame Presentation Server (Release 4.0 or 4.5) or Microsoft Terminal Service (MTS) environment.

Important Note About Cisco IPCC Solution Deployment

Cisco's IPCC solution consists of a number of Cisco products. These products are thoroughly tested and documented to ensure that the solution has extremely high availability and can be supported easily and quickly.

Deploying platforms, configurations, or third party applications that are not explicitly identified in Cisco product documentation as supported will significantly impact the performance and capacity of the Cisco IPCC solution. Using such non-standard components may contribute to extensive outages that could seriously impact your business and your customers. It will also greatly hinder the ability of the Cisco Technical Assistance Center (TAC) organization to diagnose and resolve issues, to the extent that resolution of issues may not be possible.

Cisco TAC will support Cisco products and documented third party applications and configurations that are part of your IPCC deployment. However, Cisco TAC cannot and will not guarantee the overall stability of platforms that use non-supported components or configurations. Cisco TAC will not be able to assist in troubleshooting any problems that exist for the agent desktops on unsupported platforms or configurations. In addition, Cisco TAC may be unable to provide assistance of any type if initial analysis suggests that unsupported platforms might be contributing to the issue. In such cases, Cisco TAC will provide best effort support and will only be able to troubleshoot the supported applications and components of your Cisco IPCC solution, not the overall solution environment.

For these reasons, Cisco strongly recommends that the IPCC solution be deployed in accordance with Cisco's published solution design guidelines. If you have questions about these guidelines or about supported IPCC solution components, consult the Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0), 7.1(1), 7.1(2), and 7.5(1) Hardware and System Software Specifications (Bill of Materials) and the Cisco IPCC documentation set.

Audience

This manual is intended for Cisco and partner system administrators and integrators.
Organization

The following table describes the information contained in each chapter of this guide.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1: Integrating Cisco CTI OS into a Citrix MetaFrame Presentation Server Environment</td>
<td>Guides a Citrix or MTS administrator through the installation and configuration of Cisco CTI OS Release 7.5(1) in a Citrix MetaFrame Presentation Server (Release 4.0 or 4.5) or Microsoft Terminal Services environment.</td>
</tr>
<tr>
<td>Appendix A: Registry Settings</td>
<td>Provides the registry settings used by the Cisco CTIOS Client.</td>
</tr>
</tbody>
</table>

Related Documentation

Documentation for Cisco Unified ICM/Unified Contact Center (IPCC) Enterprise & Hosted, as well as related documentation, is accessible from Cisco.com at http://www.cisco.com/web/psa/products/index.html.


For documentation for these Cisco Unified Contact Center Products, go to http://www.cisco.com/web/psa/products/index.html click on Voice and Unified Communications, then click on Cisco Unified Contact Center Products or Cisco Unified Voice Self-Service Products, then click on the product/option you are interested in.

- Also related is the documentation for Cisco Unified Communications Manager, which can also be accessed from http://www.cisco.com/web/psa/products/index.html
- The Product Alert tool can be accessed through (login required) http://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice
Conventions

This manual uses the following conventions.

<table>
<thead>
<tr>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boldface type is used for user entries, keys, buttons, and folder and submenu names.</td>
<td>Choose <strong>Edit &gt; Find</strong> from the ICM Configure menu bar.</td>
</tr>
<tr>
<td>Italic type indicates one of the following:</td>
<td>• A <strong>skill group</strong> is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td>• A newly introduced term</td>
<td>• <strong>Do not</strong> use the numerical naming convention that is used in the predefined templates (for example, <code>persvc01</code>).</td>
</tr>
<tr>
<td>• For emphasis</td>
<td>• IF <em>(condition, true-value, false-value)</em></td>
</tr>
<tr>
<td>• A generic syntax item that you must replace with a specific value</td>
<td>• For more information, see the Cisco ICM Software Database Schema Handbook.</td>
</tr>
<tr>
<td>• A title of a publication</td>
<td></td>
</tr>
<tr>
<td>An arrow (&gt;) indicates an item from a pull-down menu.</td>
<td>The Save command from the File menu is referenced as <strong>File &gt; Save</strong>.</td>
</tr>
</tbody>
</table>

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.

Documentation Feedback

You can provide comments about this document by sending email to the following address:

mailto:ccbu_docfeedback@cisco.com

We appreciate your comments.
CHAPTER 1

Integrating Cisco CTI OS into a Citrix MetaFrame Presentation Server Environment

Introduction

CTI OS Release 7.5(1) now supports the running of CTI OS Desktop applications within a Citrix MetaFrame Presentation Server (Release 4.0 or 4.5) or a Microsoft Terminal Services (MTS) environment. The Citrix MetaFrame Presentation Server permits hosting of several concurrent client applications simultaneously. This hosted environment reduces the deployment and software maintenance burden on CTI OS administrators and corporate information technology (IT) teams.

This document is intended to guide a Citrix or MTS administrator through the installation and configuration of Cisco CTI OS Release 7.5(1) in a Citrix MetaFrame Presentation Server (Release 4.0 or 4.5) or Microsoft Terminal Services environment.

Limitations

The following limitations apply to Cisco CTI OS integrations with the Citrix MetaFrame Presentation Server:

- Versions of Citrix MetaFrame Presentation Server prior to Version 4.0 are not supported. Earlier versions have limitations for publishing Microsoft .NET based applications.
- CTI OS Java CIL client applications are only supported on Citrix MetaFrame Presentation Server (Release 4.0 or 4.5) for the Windows platform. There is no planned support for Citrix MetaFrame Presentation Server (Release 4.0 or 4.5) on UNIX.
- CTI OS Client Desktop sounds such as dial tones and DTMF tones are not audible.

The following limitations apply to Cisco CTI OS integrations with the Microsoft Terminal Services:

- Versions of Microsoft Terminal Services prior to MTS Windows 2000 Server are not supported.
- CTI OS Client Desktop sounds such as dial tones and DTMF tones are not audible.

Supported Desktop Systems

CTI OS Clients hosted by a Citrix Independent Computing Architecture (ICA) Client are supported only on GEN-10-002-Class and GEN-10-003-Class hardware, as specified in the Cisco ICM/IPCC Enterprise & Hosted Edition Releases 7.0(0), 7.1(1), 7.1(2), and 7.5(1) Hardware & System Software Specifications (Bill of Materials) which is accessible from:

Supported Platforms

The following server platforms are supported.
- Windows 2003 Server with Terminal Services
- Windows 2000 Server with Terminal Services

Note
Cisco has no plans to support the Citrix MetaFrame Presentation Server on UNIX.

The following client platforms are supported.

<table>
<thead>
<tr>
<th>Client Platform</th>
<th>Supported with Citrix ICA Client?</th>
<th>Supported with MTS Clients?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000 Professional SP4</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows XP Professional SP2</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Windows Vista</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 4</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Note
Designing of your Microsoft Terminal Server implementation should be done in consultation with a Microsoft Certified Engineer. In particular, the guidance of a Microsoft Certified professional is essential to determine how many agents can be accommodated on an MTS suite. Citrix users should obtain the services of a Citrix Certified Administrator to provide similar deployment assistance for Citrix.

Supported Citrix ICA Clients

CTI OS clients published in a Citrix MetaFrame Presentation Server can be accessed only using the following Citrix ICA clients:
- ICA Win32 Program Neighborhood Client
- ICA Win32 Web Client
- ICA Win32 Program Neighborhood Agent
- ICA Client for Linux

Supported MTS Clients

CTI OS clients installed in a Microsoft Terminal Services Server can be accessed only using the following MTS clients:
- Terminal Services Client for Windows 2000
- Microsoft Remote Desktop Connection
Installing and Configuring CTI OS under the Citrix MetaFrame Presentation Server or Microsoft Terminal Services

The process of installing and configuring CTI OS for use with a Citrix MetaFrame Presentation Server or Microsoft Terminal Services environment involves the following procedures.

- Installing Cisco CTI OS
- Configuring the Call Center Agent Windows Users

The following additional procedures are necessary for Citrix only.

- Publishing CTI OS Clients in Citrix MetaFrame Presentation Server
- Configuring a Citrix ICA Connection

The following additional procedure is necessary for MTS only.

- Configuring Remote Desktop Connection

The following sections explain these procedures.

Install Cisco CTI OS

To install Cisco CTI OS software, do the following steps.

Step 1 Insert the CTI OS software CD.
Step 2 From the Start menu select Control Panel.
Step 3 On the Control Panel, select Add/Remove Programs.
Step 4 On the Add/Remove Programs screen, double click on the icon marked Add New Programs.
Step 5 On the Add New Programs screen, click on the button marked CD or Floppy.
Step 6 Click Next on the Install From Floppy Disk or CD-ROM screen.
Step 7 Click Browse and locate the CTI OS Toolkit Install program. For CTI OS major releases, this program is named Setup.exe. For Maintenance Releases and Engineering Specials, this program name is in a format that identifies the release number (for example, CTIOS8[17].0(1)_SR1_39.exe).
Step 8 For CTI OS major and minor releases, follow the directions in the CTI OS System Manager’s Guide for ICM/IPCC Enterprise & Hosted Editions to install Cisco CTI OS on the Citrix MetaFrame Presentation Server. Accept the default location provided by the CTI OS Setup program. For Service Releases and Engineering Specials, follow the installation instructions for that particular package.
Step 9 If the CTI OS installation program does not reboot the system automatically, click Finish.

Configuring the Call Center Agent Windows Users

Note The user and group creation must adhere to your environment Domain and security policies. The users and group mentioned in this section must be accessible from the machine hosting the Citrix MetaFrame Presentation Server.
To configure call center agent users within Windows, do the following steps.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Create a new Windows user group named CTIOSCitrixUsers (for Citrix) or CTIOSMTSUsers (for MTS).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Create a Windows user per call center agent.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Make each user a member of the following Windows user groups:</td>
</tr>
<tr>
<td></td>
<td>- CTIOSCitrixUsers or CTIOSMTSUsers</td>
</tr>
<tr>
<td></td>
<td>- Users</td>
</tr>
<tr>
<td></td>
<td>- Remote Desktop Users</td>
</tr>
<tr>
<td>Step 4</td>
<td>On some platforms such as Windows Server 2003 Enterprise, you also need to make the IPCC Supervisor users member of the group Power Users.</td>
</tr>
</tbody>
</table>

### Configuring the System Registry After Installation

After you install the CTI OS desktop software on the Citrix MetaFrame Presentation Server, see Appendix A, “Registry Settings” for a list of the registry settings used by the Cisco CTI OS Client. If you are required to modify the CTI OS Server connection information used by the CTIOS Desktops for the initial client settings download, go the the Cisco CTI OS client install directory and run the Setup.exe. The setup Program will prompt for the new server information and exit.

### Configuring Tracing

The CTIOS Tracing configuration is now classified in two categories: Global Machine Settings and Per User Settings.

Global Machine settings are those settings that apply to all the CTI OS trace services that are running on the computer. For detail on the settings that apply, refer to the CTI OS System Manager’s Guide for ICM/IPCC Enterprise & Hosted Editions, Release 7.5(1).

Per User Settings are settings that only apply to the CTI OS trace service running under the current user session. The only setting that applies is TraceMask. See Appendix A for details.

#### TraceFileName

This setting contains the system variable %HOMEPATH% prepended to the log file name, as shown in the following example:

```
"%HOMEPATH%\CtiosClientLog"
```

**Note**

Specifying the home path may add excessive tracing overhead that will affect the performance of Citrix MetaFrame Presentation Serve or Microsoft Terminal Services Server. For more details refer to http://support.citrix.com/docs/. In addition, this directory must have read/write and execute access for the user members of the CTIOSCitrixUsers Windows user group.

#### TraceMask

TraceMask is both a global and a per user setting that controls the tracing level for CTI OS Desktops running on the host.
Chapter 1: Integrating Cisco CTI OS into a Citrix MetaFrame Presentation Server Environment

Installing and Configuring CTI OS under the Citrix MetaFrame Presentation Server or Microsoft Terminal Services

---

**Note**

Tracing should be enabled for troubleshooting purposes only. If it is necessary to enable tracing, the recommended setting for a Citrix or MTS environment is 0x0000007 rather than the standard CTI OS default of 0x40000307.

---

### Publishing CTIOS Clients in Citrix MetaFrame Presentation Server (Release 4.0 or 4.5)

**Note**

The procedure in this section is not applicable for MTS.

To publish the applications in the Citrix MetaFrame Presentation Server, do the following steps.

**Note**

The settings indicated in the following steps were selected carefully to ensure the correct functioning of the CTI OS Clients. Combinations other than those mentioned in these steps are not supported by Cisco.

**Step 1**

Launch the Management Console for MetaFrame Presentation Server.

**Step 2**

From the tree on the left, select the Farm on which you want to publish the CTI OS Clients.

**Step 3**

Select the branch marked as **Applications**.

**Step 4**

From the **Actions** menu select **New** and then select **Published Application**. The Publish Application screen appears.

**Step 5**

Enter a user friendly Display Name and a clear description,
Step 6  Click Next. The Specify What to Publish screen appears.

Specify the following information.
- For **Application Type**, select Application.
- For **Command Line** and **Working Directory**, specify the full path and working directory of the CTI OS Client you are publishing.
- Leave the **Isolate Application** box unchecked.

Step 7  Click Next. The Program Neighborhood Settings screen appears.
Specify the name of a Program Neighborhood Folder that will contain the application icon. Optionally, specify the following additional information:

- Addition of an application shortcut to the client Start menu
- Addition of a shortcut to the client desktop
- An application icon

Step 8 Click Next. The Specify Application Appearance screen appears.
Step 9 Click Next. The Specify Client Requirements screen appears.

Specify a 1024x768 resolution Session Window Size and High Color (16 bit) depth. Uncheck the boxes in the Application Startup Settings group.

**Note** If a lower resolution is required for accessibility purposes, Cisco will support resolutions as low as 800x600.
Remove the check from the **Enable Legacy Audio** box. If your site security policies requires that your ICA client connection be secure, check on the **SSL and TLS Protocols** check box (see the Citrix *MetaFrame Presentation Server Administrator’s Guide*). Ensure that the **Printing** check box is checked.

**Step 10** Click **Next**. The Specify Application Limits screen appears.
Step 11  Click Next. The Configure Access Control screen appears.

Accept the defaults unless you site security policies require different settings.
Step 12  Click Next. The Specify Servers screen appears.

Specify the Citrix MetaFrame Presentation Server or servers on which the CTI OS Client will run.

Step 13  Click Next. The Specify Users Screen appears.

Step 14  Specify the users that will be allowed to run the CTIOS Client.

Step 15  Click Finish.

Configuring a Citrix ICA Connection

Note  The procedure in this section is not applicable for MTS.

To create ICA connections for the user to run the applications, do the following steps.

Note  The settings indicated in the following steps were selected carefully to ensure the correct functioning of the CTI OS Clients. Combinations other than those mentioned in these steps are not supported by Cisco.

Using the Citrix Program Neighborhood Client

Step 1  Launch the Citrix Program Neighborhood Client. Double click on the Custom ICA Connections icon.
Chapter 1      Integrating Cisco CTI OS into a Citrix MetaFrame Presentation Server Environment

Installing and Configuring CTI OS under the Citrix MetaFrame Presentation Server or Microsoft Terminal Services

The Custom ICA Connections screen appears.

Step 2   Double click on the Add ICA Connection icon. An Add New ICA Connection screen appears.

Step 3   From the pull down list, select either Local Area Network or Wide Area Network.
Chapter 1 Integrating Cisco CTI OS into a Citrix MetaFrame Presentation Server Environment

Installing and Configuring CTI OS under the Citrix MetaFrame Presentation Server or Microsoft Terminal Services

Note
Low-bandwidth connections such as Dial-up or ICA-Dialin are not capable of supporting the CTI OS Client real-time telephony events, and therefore are not supported.

Step 4
Click Next. The following screen appears.

![Add New ICA Connection](image)

Step 5
Specify a user friendly description for the new ICA Connection.

Step 6
If your site security policies require a secure connection between the Citrix MetaFrame Presentation Server and your ICA Client host computer, select SSL/TLS + HTTPS for the network protocol. Otherwise, select TCP/IP. Cisco will not support any of the other optional protocols (TCP/IP+HTTP, IPX, SPX and NetBios) shown in the ICA connection wizard.

Step 7
Select the Published CTIOS Application or MetaFrame Presentation Server computer as follows:

a. To select a Published application select the Published Application radio button. From the pull down list, choose the desired CTI OS Client.

b. To select a Presentation Server select the Server radio button. From the pull down list, select the Presentation Server of your choice. Selecting this option will open a Remote Desktop at the Presentation Server for the windows user configured on the ICA connection.

Step 8
Click Next. The following screen appears.
Chapter 1  Integrating Cisco CTI OS into a Citrix MetaFrame Presentation Server Environment

Installing and Configuring CTI OS under the Citrix MetaFrame Presentation Server or Microsoft Terminal Services

Step 9  Select the type of window used to display the published CTI OS client. If you choose Seamless Window, the CTI OS Client will run using its standard user interface as if the application was running on the agent desktop host. If you choose Remote Window Desktop, the CTI OS Client user interface will be contained within the Citrix Desktop window.

Step 10 Click Next. The following screen appears.

Step 11 If you do not require a secure connection use the default encryption. Otherwise, select the level that applies to your environment.

Note  Be careful in selecting the encryption level, as this can affect both the latency and response time of any published application. Work in conjunction with your Citrix configuration and network administrators to choose the appropriate level that will insure both optimal performance and security for your application.
Step 12 Ensure that the Session Reliability Enable checkbox is checked. Disabling this feature will affect the failover capabilities of your Citrix ICA client and will result in loss of connectivity with the Citrix MetaFrame Presentation Server. In addition, manual reset and logout of the dangling ICA session in Citrix MetaFrame Presentation Server may be required, and manual logout from Cisco IPCC / Legacy PBX will be required.

Step 13 Click Next. The following screen appears.

![Add New ICA Connection](image)

Step 14 Specify the login information that will be associated with the connection. This is the windows login information associated with the Call Center Agent in the Windows Domain on which the Citrix MetaFrame Presentation Server resides.

Step 15 Click Next. The following screen appears.

![Add New ICA Connection](image)

Step 16 Choose any of the color depths available in the pull down list except 16 Color Depth. Cisco recommends "Hi Color (16-bit)."

Step 17 Click Next, then click Finish. An icon for the newly created connection appears on the Citrix Program Neighborhood screen.
Step 18  Click on the icon for the newly created connection. Select the File menu, then select Options. A dialog box similar to the following appears.

![Dialog box image]

Step 19  Check the Use disk cache for bitmaps checkbox. Accept all other defaults.

Important:

- If better performance is required at your Citrix MetaFrame Presentation Server, you can remove the check from the Use data compression check box. This setting will eliminate the additional overhead at the Presentation Server required to compress the traffic sent to the ICA client. Before unchecking this setting, please consult with your Citrix Administrator and make sure that the Citrix server works properly after the change.
- Never override the Sound Custom Default. Sound is disabled by default and Sound is not supported with published CTIOS Clients.
• Queuing mouse events and key strokes will affect the responsiveness of the CTI OS Client since the ICA client will send mouse activity less often to the Presentation Server. Cisco does not recommend the use of this setting, especially since low-bandwidth connections are not supported for published CTI OS Clients.
• Speed Screen Latency should always be set to Off. This feature is intended to improve the user experience with ICA connections over low-bandwidth connections.

**Step 20** Click OK.

---

**Using the Citrix Program Neighborhood Agent**

**Step 1** Using the Program Neighborhood Agent Site in the Access Suite Console:

a. Configure the authentication methods according to your site security policies.

b. Configure the following Session options.

• In the Client Session Sizes window, remove the check on the 640x480 check box. If you define a custom window size (Resolution) this must not be lower than 800x600.

• In the Client Resources Window, remove the check on the following check boxes:
  • In the Color depth options users can select group, remove the check on the box marked as 16.
  • In the Audio options users can select group, remove all the marks from all check boxes.
c. In the Manage Server Settings window remove the check on the Allow user to customize the server URL check box.

**Step 2**

Install the Citrix Program Neighborhood Agent software at each agent desktop and configure the URL to the server running the Program Neighborhood Agent Site, usually: http://YourPresentationServerWebInterfaseHost/Citrix/PNAgent.

For more detailed information about how to configure Program Neighborhood Agent, see the Client for 32-bit Windows Administrator's Guide at [http://support.citrix.com/docs](http://support.citrix.com/docs).

**Using the Citrix Web Client**

At each agent workstation, install the appropriate MetaFrame Presentation Server Web Client. The ICA connection settings will default to those set when the CTI OS Client was published in the Citrix MetaFrame Presentation Server.

**Configuring Microsoft Remote Desktop Connection**

**Note**

The procedure in this section is not applicable for Citrix Metaframe Presentation Server (Release 4.0 or 4.5).

If you will be using Microsoft Terminal Services instead of Citrix Metaframe Presentation Server, you need to perform the following configuration steps in Microsoft Remote Desktop Connection.

**Step 1**

On the General tab, enter the following information:

- In the Computer field, enter the host name or IP address of the MTS Server.
In the User name and Password fields, enter the windows login information associated with the Call Center Agent in the Windows Domain on which the MTS Server resides.

In the Domain field, enter the domain in which the MTS Server resides.

**Step 2** Click the Save As button.

**Step 3** On the Experience tab, select the appropriate connection speed for your connection to the MTS server from the drop-down list.

**Step 4** On the Local Resources tab, ensure that sound is disabled.
**Step 5**  Accept the default values on all other tabs.

**Note**  For information on saving a connection configuration, refer to the Remote Desktop Connection online help.
Registry Settings

The following are the registry settings used by the Cisco CTIOS Client.

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.]

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\CTIOS Client]

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\CTIOS Client\7.5.1]

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\CTI Desktop]
"SoundFilesPathName"="e:\Program Files\Cisco Systems\CTIOS Client\CTIOS Shared\IPMedia"
"LocalPhoneType"="Other"

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\CTI Desktop\CtiOs]
"InstallDir"="e:\Program Files\Cisco Systems\CTIOS Client"
"Toolkit"="e:\Program Files\Cisco Systems\CTIOS Client\CTIOS Toolkit"
"CtiOsA"="192.168.252.75"
"CtiOsB"="192.168.252.75"
"PortA"=dword:0000a42d
"PortB"=dword:0000a42d
"Heartbeat"=dword:00000005
"PeripheralID"=dword:00001388
"ShowFieldBitMask"=dword:0000ffff
"AgentPhone"="e:\Program Files\Cisco Systems\CTIOS Client\CTIOS Desktop Phones"
"MaxHeartbeats"=dword:00000003

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems\CTI Desktop\LastLogin]
"ProfileName"="IPCC/SoftACD"
"AutoLogin"=dword:00000001
"AgentID"="2268"
"AgentInstrument"="2281"
"ClientAddress"="192.168.252.104"
"PcapDeviceNumber"="192.168.252.104"

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\CTIOS Tracing]

[HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\CTIOS Tracing]
"TraceServer"="e:\PROGRA~1\CISCOSS~1\CTIOSC~3\CTIOSS~1\COM\CTIOST~1.EXE"
"TraceFileName"="CtiosClientLog"
"TraceMask"=dword:00000a0f
"MaxDaysBeforeExpire"=dword:00000007
"MaxFiles"=dword:00000005
"MaxFileSizeKb"=dword:00000800
"FlushIntervalSeconds"=dword:0000001e